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Crear un PNR 

Descubrirás lo fácil que es hacer una reservación con solo usar el ratón. 
Usando Viewpoint™, podrás crear una reservación o PNR (Passenger Name 
Record) con datos básicos en solo unos minutos. 

Aprenderás como usar Viewpoint™ para seleccionar y vender segmentos 
Aéreos,  renta de Autos, reservaciones de Hoteles, ingresar información del 
pasajero, cotizar y finalizar la transacción. 

 Objetivos  

Al terminar esta lección, podrás usar Viewpoint™ para completar un PNR 
básico: 

• Vender segmentos aéreos.  

• Ingresar la información mandatoria para un PNR.  

• Cotizar los vuelos.  

• Finalizar y cerrar la transacción.  

 Vender Segmentos Aéreos 

Después de haberse firmado en Focalpoint® y abrir Viewpoint™, podrás 
empezar a crear un itinerario desplegando una disponibilidad en base a la 
solicitud del cliente. Teniendo la disponibilidad presente, podrás seleccionar 
los vuelos de ida así como los de regreso, toda la información solicitada 
aparecerá en una sola pantalla. 
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Disponibilidad general 

Para acceder a un desplegado de disponibilidad a través de Viewpoint ™ se 
pulsara sobre las siguientes íconos. 

1. Desde la ventana de Viewpoint pulsar   Air  →  Availability →  General  

Ejemplo.  

 
Proporciona información acerca de los vuelos ofrecidos por las 
aerolíneas entre ciudades y si tienen espacios disponibles 

Ejemplo Pantalla de Disponibilidad Aérea. 

 

                                                                                                                      
2.    Ingresar la información básica del vuelo, fecha, ciudad de salida, ciudad 

de llegada. 

3.    Pulsar el botón Add para agregar el vuelo solicitado a la disponibilidad. 

4.    Ingresar fecha de regreso. 
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Nota. Las ciudades de salida y de llegada cambiaran automáticamente en 
sentido contrario asumiendo que se trata de un viaje redondo. 

Si se desea comprobar la disponibilidad de ciudades con varios aeropuertos, 
como la ciudad de Nueva York   NYC, JFK, etc,  se deberá marcar el 

recuadro  All airports.        para que muestre la 
disponibilidad de todos los aeropuertos de esa ciudad. 

Ejemplo. 

 

Disponibilidad con enlace y aerolínea especifica 

Seleccionar Air → Availability→ Carrier Specific/ Link Option Display 

 
Auto- tab  □  .- Permite ingresar rapidamente códigos de aeropuerto ciudad o 
aerolínea sin tener que pasar de un recuadro a otro, si se prefiere ingresar el 
nombre de una ciudad o aeropuerto debera dar clic en la casilla de 
verificación Auto-tab.  
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  Añade cada información capturada 

  Modifica la información seleccionada 

  Borra la información seleccionada. 

  Busca la información seleccionada. 

   Cancela una búsqueda   

Nota. Al pulsar sobre Add cuando se solicita disponibilidad los destinos se 
intercambian asumiendo que se trata de un viaje redondo. 

Ejemplo. Pantalla de disponibilidad. 

 

Símbolos. 

   escalas 

   equipo 

 máximo nivel de enlace 

 alto nivel de enlace 

   forzosamente se debe enlazar 

 *   despúes de la aerolínea indica que es un vuelo de código compartido 

***  Indican el nivel más alto de conexión entre Apollo y la linea aérea por 
lo tanto se puede vender desde esta opción o con enlace (link). 

**  Indica que se tiene un alto nivel de enlace. 
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*    Se debe enlazar forzosamente (link) esta opción es sólo para observar que 
vuelos operan, no para vender. 

Seleccionar vuelos desde la disponibilidad 

1. Seleccionar con un clic el vuelo de salida deseado. 

2. Pulsar Ctrl, clic en el vuelo de regreso deseado. 

Ejemplo Pantalla de Selección de Vuelos. 

 

  Permite pedir más opciones de vuelos 

  Se puede observar la información en general del vuelo, que 
aerolínea lo opera, la duración del viaje y alimentos en general. Es de mucha 
utilidad en caso de que no se este familiarizado con los códigos y se quisiera 
ver información presentada en un formato claro. 
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Ejemplo Pantalla Details. 

 
 

 Permite conocer alimentos y servicios a detalle. Se selecciona 
inflight service y posteriormente la clase en la que se quiere reservar.  

Ejemplo de la Pantalla Inflight Services.. 

 

   Permite cerrar la ventana actual y regresa a la ventana anterior.  
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Cotizar segmentos aéreos. 

En VIEWPOINT ™ se puede cotizar antes de vender, utilizando  
Cotiza tarifas para el itinerario, así mismo  permite seleccionar modificadores 
de precios y de boletos. 

1. Fare Quote→ Unknown→ Number of passengers→ Passenger 
Description→ OK 

Ejemplo. 

 
Nota. El sistema por default cotiza por persona adulta, si se quiere 
cotizar una tarifa para niños, adultos mayores, infantes, etc. Es necesario 
especificarlos por medio de Passenger Description.   

Ejemplo de la  Pantalla que Muestra la Tarifa.  

 
− Quote Date.- Muestra la fecha en la que se solicito la información de 

la tarifa  
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− Last Date to Purchase Ticket. - Indica la fecha para el último día de 
compra del boleto  

− Total Fare.-  Presenta la cantidad total a pagar por persona adulto en 
moneda local. 

− Base Fare.- Muestra el precio de la tarifa base sin impuestos 
incluidos en dólares. (Por tratarse de un vuelo internacional) 

− Equivalent Fares.- Indica el equivalente en moneda local, la tarifa 
base. 

− Taxes.- Presenta el valor total de los impuestos en moneda local.  

2.    Seleccionar passenger and fare details. Para desplegar a detalle la tarifa o 
gran total   

 
    indica que se puede desplegar información adicional al dar clic sobre 

este símbolo 
 

Mostrar el menú de  Reglas. (Rules) 

3.    Se podrán ver las reglas para cada componente de la tarifa, se selecciona 

dicho componente,  enseguida el icono de reglas   

4.    A este punto existen dos formas de regresar al itinerario con el botón   

 o  con  el botón   . 

Nota. Para poder regresar a la pagina anterior se teclea Ctrl Tab 
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Datos generales 

5.    Ingresar datos generales obligatorios del pasajero.                                                                

 

Create/ Edit Customer Information... ► Name 

 
Nombre 

Apellidó Nombre→ Sufijo→ Add 

 

 
Viajero frecuente 

Aerolínea→ Número de viajero Frecuente→Add  
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Teléfono 

Código de la ciudad → Ubicación→ Número Telefónico→Add 

 

Nota. El primer campo telefónico siempre será ocupado por el de la Agencia 
de Viajes y este nunca se deberá eliminar. 
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Dirección.  

Customer Addresses ó Delivery Field (según la información que tenga el 
sistema contable de la agencia) → Name→ Street Address→ City State or 
Province→ Optional field→ Postal Code→ Add 

  

 
Tiempo Límite 

Tau →  Date→ Ok 

Este cuadro de diálogo permite definir los parámetros para la emisión del 
boleto del PNR. 

 
Volver a Itinerary para ver la información sobre la preparación del boleto en 
el menú. 
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 Para poder ver la información,  doble 
clic debajo de la barra de desplazamiento y se muestra Ticketing 
Arrangement.  

 
Ventana para agregar la forma de pago 

 

Vender 
 

6.    Elegir la opción comprar (Sell) → la clase en la que se requiere 
reservar→ Sell 
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Finalizar 

7.    Finish → Save PNR → Recibido → Save 

 
Ejemplo de la Pantalla Save PNR 

 
Después de salvar se debe verificar que los status de vuelos sean HK y 
que a mano superior izquierda se tenga el Record Localizador de Apollo.  

Obtener Clave de Confirmación de la Aerolínea. 

9.    Customer→ Ignore and Redisplay  

 

 
De este modo conseguimos la clave de confirmación de la aerolínea, y la 
podemos observar desplegando. 

Nota. Si no se reconfirma el haber obtenido la clave ACKN presionando 
IR, los siguientes movimientos o campos que se agreguen no serán 
tomados por el sistema, ya que al salvar o guardar la información 
responderá con la leyenda ¨SIMUL CHGS¨ Cambios simultáneos, la 
acción a tomar es IR, se perderán estos últimos cambios hasta donde la 
aerolínea toco el record enviando la clave ACKN, y se tendrán que 
ingresar los datos. 
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En esta opción de Remarks → Vendor Locators  se encuentra la clave 
de confirmación de la aerolínea. En el caso de no arrojar la clave de 
confirmación  la aerolínea mandar  a una queue especial para Help Desk, 
Remarks solicitando la clave de confirmación  de la aerolínea o también  
por medio del Chat en.  www.galileo.com.mx 

S*ATM/AYUDA  En este tópico ayuda se podrá verificar a que queue 
de Help Desk se  va a mandar el Remark. 

Finalizar  Reservación y Comenzar una Nueva Reservación. 

10.   Customer → Ignore 

 

 

Crear un record en una clase especifica 

Esta ruta servirá cuando se tienen pasajeros que piden una clase específica 
como bussines o primera, o bien para tarifas netas o de paquete.  

1. Para este tipo de reservación como en primer lugar se elige itinerario y se 
compra, hasta este punto no se ha cotizado ya que si es Bussines o 
primera el precio no es prioridad para el cliente y si es Neta es probable 
que la tarifa no este en Apollo. 

2. Se agregan los datos obligatorios del pasajero 

3. Se salta el paso de tiempo límite. 

4. Después se elige el menú Fares → Fare Quote enseguida se selecciona 
cada tipo de pasajero a mano inferior derecha aparecerán las siguientes 
opciones de compra. 

 Cotiza en la clase que se reservo. 

  Cotiza lo más económico disponible y aplicable 
con la aerolínea y los vuelos elejidos. 

   Cotiza lo más económico aplicable no verifica 
disponibilidad. 

  Para utilizar esta opción se suguiere que los vuelos 
vendidos esten aun en clase Y, porque comparara la clase Y contra la 
más economica disponible y arrojara la diferencia como un ahorro al 
pasajero. (no olvidar cambiar posteriormente a la clase económica). 
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  Cotiza lo más economico incluso con otras 
Aerolíneas. 

5.    Por lo tanto la en este caso la opción que se elige es Quote as Booked.  

** Al momento de cerrar también se tiene la opción de agregar el tiempo 
limite** 

6.    Save PNR→ Change Ticketing → Ticketing → Tau → Date→ Received 
→ Save PNR 

Cambio de Clase 

Cuando se tiene un record creado en una tarifa alta y se quiere cambiar a la 
más barata se realiza un cambio de clase. 

Fares →  Fare Quote → Best Buy → OK → Reebok  Fare → 0K→ Finish  
Save → PNR →  Recibido →  Save 

 

     

 

Desplegar records construidos. 

Customer → Retrieve PNR  

 
Por record localizador. 

 
Por Apellido. 
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Cancelar Itinerario. 

Customer→ Cancel Itinerary → Yes→ Finish→ Save 

Ignorar Un Record.    

Customer→ Ignore → Yes 

Salir y Desfirmarse Del Sistema. 

Customer→ Exit and Sign Off 

Crear un Record con Enlace (Link). 

Air → Availability → Carrier Specific/ Link Options Display… 

és de añadir no se modifica en Automático el regreso como en la 
disponibilidad General ya que se tiene que presionar el boton SEARCH  para 
la búsqueda de la  disponibilidad de ida, despúes se vende este tramo y se 
repiten los pasos para el regreso, de igual manera como se realiza en  
Focalpoint el procedimiento para terminar una reservación con  Link es el 
mismo que se manejo anteriormente segun las necesidades de cada 
reservación.  

Modificaciones 

Desde que se esta pidiendo disponibilidad se puede modificar según lo que el 
cliente solicite. 

Search→ Update → Modify 

  
Regresa a la solicitud original a la cuál, segmento por segmento se debe ir 
actualizando y presionando Modify.  

Arribo Desconocido  ARNK 

ARNK  

Se Selecciona el Segmento Aéreo→ Air→ ARNK  
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Ejemplo 

 

Modificar Segmento Aéreo. 

Cuando se cuenta ya con una ruta Seleccionar→Clic Derecho→ Modify 

Ejemplo Pantalla  Modify Segments 

 

 Cambia el status del segmento. 

 Cambia el horario 

 Cambia de clase 

 Cambio de fecha 
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Reordenar Segmentos. 

Tools → Reorder Segments → Seleccionar Segmento a Ordenar →  Move 
up→ Move Down  

 
Ejemplo pantalla Reorder Segments. 

 

Grabar tarifa 

Fares → Fare Quote → Best Buy (opcional) → Store Fare → Add Ticketing 
Modifiers → Plating Carriers → Commission → OK 

 

 

 



Viewpoint 

20 ViewpointTM Segmento Aero, Autos y Hotel Guia de Estudio, Agosto 2007 

Ver la Tarifa Grabada 

Se despliega la aplicación Stored Fares 

 
Cancelar Tarifa Grabada. 

Fares → Cancel All Stored Fares→ K 

    

 

Actualización de Tarifa 

Cada  vez que existe un cambio en el itinerario,  el sistema no permite cerrar 
el record enviando el mensaje ¨MODIFY ATFQ¨ el cual  pide que se 
actualice la tarifa por estos cambios, por lo tanto ya no es necesario 
especificar el tipo de pasajeros simplemente se elige la opción Verify All 

Finish→ Save PNR →Verify All →Recibido→ Save 

     →       

 Este icono repite la tarifa, sólo se debe hacer cuando ya 
esta boleteado y el cambio es involuntario. Ejemplo cambios de horarios que 
la aerolínea realiza. 

Lista de Tarifas  

1. Fares→ Tarif Display→ Origen→ Destino→ Fecha→ Aerolínea 
(indistinto)→ One Way →Round Trip→ Search 
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Ejemplo  

 
 

2.    Seleccionar tarifa →Rules→ Detailed Rules o Summary Rules 

Ejemplo Pantalla Lista de Tarifas. 

 

 Muestra todas las reglas 

 Muestra el resumen de todas las reglas 
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Ejemplo  Pantalla que muestra el resumen de las reglas. 
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Shop 

Permite consultar horarios y tarifas disponibles con o sin un itinerario 
reservado. El cuadro de dialogo Shop es muy parecido a Air Availability 
Request y Fare Quote. 

Shop→ Low Fare Shopping Tool 

 

 Esta herramienta incluye las preferencias Private 
Fares™  y TravelScreen™   

Viajes  Dentro de Estados Unidos 

Shop→ Calendar Shop 

 

   

Asignar asientos 

1. Seleccionar Segmento→ Clic Derecho→ Seat map   

Ejemplo 

 
2.    Display Seat Map.- Despliega itinerario en la parte superior y en la parte 

inferior muestra los asientos disponibles en color azul, se selecciona y 
cambia a color gris parpadeando para indicar que ahora esta ocupado. 
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Ejemplo Pantalla del Mapa de Asientos  

 
Para ver detalles adicionales sobre el asiento, Clic con el boton derecho 
en el asiento. 

3.    SAVE 

En Seat Request Results aparece información del segmento, acción y 
estado. 

CLOSE para regresar a Itinerary.  

Clic en Seat Data 

Si se desea que los datos de asignacion de asientos se muestre 
automaticamente, hay que personalizar la pantalla dando clic en el menu 
Tools seleccionar Options, cuando aparece el cuadro de dialogo Viewpoint 
Options, dar clic en Itinerary Expand All Levels y Ok. 

Quick Assign 

Air→ Seat → Quick Seat Assign     A   Aisle seat 
                                                       W  Window  seat→ OK   

Nota. Si responde Seat Request Date Is Out Of  Range. Significa que la 
aerolínea no  permite asignaciones con tanta antelación a la partida del vuelo.      
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Remarks 

Customer→ Create/ Edit Remarks 

 

             

 
Remarks  Asociados.- Son observaciones o notas que tienen que ver con el 
algún segmento seleccionado  y se imprimen en el itinerario del pasajero. 

 
Remarks No Asociados .- Son aquellos que tienen que ver con el itinerario en 
general y se imprimen despúes de los segmentos. 

 
Remarks Generales.- Sólo son informativos para la Agencia y no se 
imprimen en el itinerario del pasajero. 

 
Document Invoice.- Esta información ya esta cargada en el back office y es 
necesario cargar la información  en Apollo por medio de las teclas rápidas.    

                                                                           
Customer ID/Postscript… Es el número de cliente tambien se carga con la 
teclas rapidas de Apollo. No se imprime. 

 
Queue Minders.- Es agendar cierto PNR para que este caiga a una Queue 
asignada para  cada agente dentro de la Agencia, anotando la razón a realizar. 

Servicios especiales 

1. Customer Create/Edit Special Services… 

  

 
2.    Vendor→ OSI Field→Add 

 
YY Avisa a todas las líneas aéreas implicadas en el itinerario. 
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Otros servicios especiales 

 
Apollo da la información pero eso no quiere decir que todas las aerolíneas 
den los mismos alimentos, esto depende de varios factores y características 
de los  vuelos.  

Por lo tanto se debe utilizar el sentido común. Una vez solicitado un servicio 
especial hay que confirmarlo con la aerolínea utilizando el siguiente formato 
para cambiar el status a confirmado. 

C: 9 : 3.HK   

C = Cambio 
9 = núm de renglón 

 : 3 = formato OSI 
. HK= activa cambio al nuevo Status 

Si ya no se requiere el Servicio Especial es necesario cancelarlo con el 
siguiente formato 

C: 9  : 3.XX  

XX = Cancela servicio 

(Exclusivo para realizar cambios de status en los campos de SSR) 

Nota. Cuando el servicio o el itinerario es cancelado por la linea aérea con el 
status HX Es necesario cambiar el status y cancelarlos con el formato .1XK  
en donde el # 1 es el segmento a cancelar ó con  .IXK en donde la letra I se 
refiere a todo el Itinerario. 
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Autos  

Objetivos  

Aprenderá a reservar un Automóvil utilizando Viewpoint™ completar las 
tareas involucradas en una reservación de automóvil,  estas tareas básicas 
incluyen. 

• Definir el criterio de la búsqueda. 

• Despliegue de reglas y descripciones para el automóvil seleccionado. 

• Vender el auto. 
 

Solicitar la Disponibilidad de Autos a través de Viewpoint™ 
 

1. Car → Availability→ Pickup Date→Time→Return Date→Time→ 
Rental Company→ Rental Location→ Rate Type→ Car Size→ Search 

 

                                                                                  

  Datos Generales 
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Ejemplo Pantalla Datos Generales 

 

 

                                                                          

Nota. En este pantalla se llenan los datos generales de la renta, fecha en 
la que se recoge, hora, fecha de entrega, arrendadora preferente hasta 3, 
locación del lugar donde se realizara la entrega del automóvil, tipo de 
tarifa semanal, diaria, etc. y el tipo de auto.    

   
2.    Especificar si hay algun código o tarifa especial, descuento etc. 
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Ejemplo Pantalla Vendor Specific 

 
Corporate Discont .- Si se cuenta con una tarifa corporativa. 

ID#.- Numero identificación  para tarifas especiales individuales. 

Rate Code.- Código de tarifa que da  la arrendadora. (Ejemplo tarifas con 
seguro) 

  
3.    Informa si el automóvil  se deja en un lugar distinto al lugar donde se 

recogió originalmente. 

Ejemplo Pantalla  One Way 

 
Nota. Si es el mismo lugar donde lo recoje y donde lo entrega se deja en 
blanco pero si la entrega es en un lugar distinto entonces si se especifica 
código de la ciudad de entrega. Ejemplo. Se va a Las Vegas y lo entrega 
en  Los Ángeles. 

 
4.    Permite especificar características especiales del Auto que se va a rentar, 

es importante seleccionar transmisión si esta es Automática o Manual, 
con Aire o sin Aire. 
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Ejemplo   

Tamaño                                Categoría 

               

 Transmission/Aire 

   
5.    Determina el tipo de tarifas si es millaje ilimitado, tarifas garantizadas así 

como para escoger el tipo de moneda por default en la moneda que esta 
cargada la tarifa o en otra moneda por medio de la lista. 

Ejemplo Pantalla Rate Categories. 
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6.    Muestra las descripciones generales de los automóviles, código, clase, 

modelo,  número de puertas, número de pasajeros,  número de equipaje. 

Ejemplo Pantalla Car Descriptions 

 

  
7.    Verifica si cuenta con el servicio para transportar el equipaje hasta la 

terminal de la Arrendadora. 

  

  
8.    Muestra las políticas generales de la Arrendadora. 

Ejemplo Pantalla Description 

 
Nota. Siempre se pone la opción de  Location a menos que el 
arrendamiento sea a nivel corporativo entonces se utiliza la opcion 
Vendor 

  Muestra el tipo de tarifas  
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Reglas 

  Muestra todas las Reglas. 

Ejemplo. 

 
También muestra las siguientes reglas. 

 
Venta 

  
9.    Al comprar pide anotar el número de vuelo esto debido a que algunas 

arrendadoras monitorean los vuelos para que el automóvil este listo al 
momento de llegada de los pasajeros. Adémas solicita nuevamente 
agregar los datos en caso de existir un descuento porcentual.    
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Ejemplo Pantalla Sell 

 
 

  
10.  Solicita datos si se trata de cliente frecuente  

Ejemplo Pantalla Customer. 

 

   
11.  En caso de existir un tipo de categoría de tarifas especiales por parte de la 

Arrendadora se descargan los datos  en esta opción.  
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Ejemplo Pantalla Rate Categories 

 

 
12.  Esta opción permite solicitar servicios especiales de equipamiento para el 

automóvil.  

Ejemplo Pantalla Special 

 

 
13.  Se compra finalmente con Sell. 

 
14.  Se finaliza y se salva.     

  

 
15.  Se ignora y redespliega.   
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Nota.  Aunque el cliente ya no lo quiera, se debe terminar la compra, porque 
el enlace entre Apollo y las arrendadora es muy alto, más que con las 
aerolíneas por lo tanto confirman antes de terminar la operación por lo tanto 
es necesario concluirla y despúes proceder a la cancelación del segmento.  

Cuando no hay clave de confirmación por parte de la arrendadora se utiliza 
FOCALPOINT con el formato HELP 411 se tabula a CONFIRM NOT 
RECORD FOR CAR HOTEL para observar a que Queu se mandara la 
solicitud de confirmación o cualquier otra observación. 

Renta de Auto Cuando Se Tiene Reservado un Tramo Aéreo 
Seleccionar el Segmento Aéreo→ Auto →Availability 

Ejemplo 

 

 

 
Ejemplo Pantalla de Disponibilidad  

 
Nota. Por Default jala la información del vuelo como fecha, hora y ciudad. 
Entonces se siguen todos los pasos anteriores para terminar la reservación.  

Modificar 

En caso de querer cambiar algún dato ya sea que se jalo automáticamente o 
que simplemente se quiere hacer un cambio. 

Selecciona el Segmento del Auto→ Clic Derecho→ Seleccionar el cambio 
que se quiere→  Modify→ Save→ Save PNR. 
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Index 

Cuando el Cliente Solicita una Arrendadora en Especial, Cerca de un Punto 
de Referencia. 

Car→ Index Vendor→ Via Reference Point→ OK 

 

 
Ejemplo Pantalla Car Location Index 

 
Nota. La opción Index permite vender cuando ya se sabe la arrendadora y la 
ciudad. 
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Venta directa 

Car→Direct Sell →Datos Arrendora→ Ciudad→ Tipo de Auto→ Sell 

 

 
Ejemplo Pantalla Direct Sell 

 

Nota. Enseguida se llenan los datos como anteriormente se menciona, en este 
caso se debe contar con el dato de RATE CODE de no ser así no se podrá 
cerrar la reservación. 

Hoteles 

Objetivos  

Al final de la lección, podrá usar Viewpoint™ para completar las tareas 
involucradas con una reservación de hotel. 

• Definir el criterio de búsqueda de hotel. 

• Desplegar las descripciones del hotel y reglas de la tarifa. 

• Vender.  

• Utilización de mapas.   
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Solicitar la Disponibilidad de Hoteles a Través de Viewpoint™ 
1. Hotel → Availability  

 

 
Datos Generales 

 
2.    In → Out → Nights → City or Airport → Occupancy →Currency → 

Search  

Ejemplo Pantalla Basic Fields 

 

 
En esta pantalla se agregan los datos básicos fecha de entrada, salida, 
numero de noches, ciudad, ocupación sencilla, doble, moneda en la que 
esta cargada la tarifa u otra distinta. 

Nota. Viewpoint asume el tipo de habitación por los nombres que se 
ingresaron y el número de noches por las fechas que se solicitan. 

  
Categoría de Tarifas 

3.    Seleccionar la categoría de la tarifa 
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Ejemplo 

 

 
 
Cadenas Hoteleras 

4.    Elegir la Cadena Hotelera de preferencia. 

Ejemplo 

 

  
Transportación 

5.    Elegir en caso de que exista transporte que traslade al pasajero con su 
equipaje hasta las arrendadoras ubicadas en el aeropuerto. 

Ejemplo 
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Tarifas Negociables. 

6.    Anotar el o los códigos en caso de existir una tarifa negociable 

Ejemplo 

 
  

Tipo de Inmueble. 

7.    Se elige el tipo de establecimiento que se necesita  

Ejemplo 

 

 
Nombre y/o Referencia del Inmueble 

8.    Se escribe un nombre y/o referencia para identificar el establecimiento.  

Ejemplo 
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Características 

9.    Se pueden elegir características especiales que solicite el huésped acerca 
del hotel con doble clic en la opción deseada.  

Ejemplo 

 

   
Otros  

10.  Especificar ciertas características de habitación y tipo de camas por 
medio de códigos. 

Ejemplo 
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La Disponibilidad de Hoteles Aparece de la Siguiente Manera   

 
 La información del hotel cuenta con imagenes. 

 muestra un nivel alto de enlace entre Apollo y el hotel. 

 Muestra el nivel más alto de enlace entre Apollo y el hotel. 

 indica el número de diamantes o categoria del hotel. 

  Complete permite ver las características de las habitaciones, 
tarifas y rate change cuando muestra una x significa que la tarifa  tiene 
cambios.  

Ejemplo Pantalla Complete. 
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  Muestra las características y servicios del hotel.  

 

  Notes permite realizar pequeñas observaciones acerca del hotel 
que se elijio. 

Ejemplo Pantalla Notes. 

 
 
 

 Una vez grabada la nota esta se identificara en el icono de notes, 
aparece un cuadro de color verde el cúal  indica que existe una nota 
relacionada al hotel, quedando grabada en la base de datos de la agencia 
local. Y se puede observar  seleccionando el icono notes. 

Reglas 

 Se pueden observar todas las reglas relacionadas con la tarifa que 
se eligió  
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Ejemplo Pantalla de Reglas 

 
También muestra las siguientes reglas. 
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Venta  

 Realiza la venta 

Sell 

Ejemplo Pantalla  Sell 

 

Finalizar la Reservación 

Finish→ Save PNR→ Received→ Save 
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Reservar Hotel en un Punto de Referencia Específico 

Hotel→ Availability→ Fechas→ Reference Point →OK  

Ejemplo  Pantalla Reference Point 

 

Reservar Hotel Cuando se Tiene un Itinerario Aéreo 

Seleccionar Segmento Aéreo→ Hotel→ Availability→Search 

Ejemplo Pantalla Para Reservar Hotel Con Segmento Aéreo 

 
Nota. Se puede observar que Viewpoint automáticamente arroja las fechas y 
el número de noches tomando en cuenta las fechas del segmento aéreo y el 
tipo de habitación de acuerdo al número de pasajeros que se ingresaron. 
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Reservar hotel utilizando mapas 

1. Map→Search→ Código de la ciudad destino→ Seleccionar destino 
deseado 

 

 

 
2.    Seleccionar ubicación exacta→Ok 

Ejemplo 

 

 



Viewpoint 

48 ViewpointTM Segmento Aero, Autos y Hotel Guia de Estudio, Agosto 2007 

Ejemplo Pantalla del Mapa. 

 
Dentro de Viewpoint se puede elejir por Hoteles 

 
Por Atracciones 
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Ejemplo. Seleccionando hotel 2,5,4 y la atracción 3. 

 
Zoom In. Permite visualizar los mapas de cerca, al dar click sobre el 
cuadro rosa. 

 

 
Ejemplo Pantalla Zoom In 

  
Zoom Out. Permite salir del zoom in y regresa al tamaño normal 
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Distance. Mide la distancia de un punto a otro en kilometros o millas.  

 

 
Ejemplo Pantalla Distance 

 
 

Joint Distance. Mide distancias unidas en kilometros o millas. 

 

 
Ejemplo Pantalla Joint Distance  

 
Plot Region. Mide el radio circular o de manera rectangular  
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Ejemplo Pantalla Plot Region Circular 

 

Se puede elejir la ubicación de varios hoteles dentro de un radio específico al 
dar doble click en ellos y estos se tornan de color azul mostrando su 
ubicación dentro del mapa. 

Ejemplo 

 
 

Buscar 

Search→New Hotel Availability 
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Ejemplo 

 
Para terminar la reservación por medio de Mapas se procede a seguir los 
pasos que se mencionaron anteriormente. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


